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Overview 
Adobe Photoshop Elements is a tool for editing images 
and making images that are ready for the Web or for 
print. 

Getting Started 
Once the application opens, a welcome window will pop 
up.  This window offers different shortcuts.  If you do not 
want to use any of these shortcuts choose to exit the 
welcome screen. 

Opening an Image 
When you first launch Photoshop Elements, you can 
select Browse for File from the pop up window.  If you 
have bypassed this window, select File  Open. 

Importing Images from a Scanner 

Select File  Import, and then select your scanner software’s import function.  For information about 
using scanning software for other scanners, refer to the scanner documentation. 

To scan an image to a computer, follow these steps: 

1. Go to File  Import  <Scanner Type> 

2. Select the type of image that you will be scanning (Color Photo, B&W Photo, B&W Drawing). 

3. Press the Preview button.  A rough sample of your image will appear shortly. 

4. Select the area that you actually want to scan (anything extra will result in bigger file size and slower 
processing).  To select a part of an image, hold down the left mouse button and drag to select the 
desired area.  You can adjust the selection by dragging any of the small squares that appear in the 
selection border. 

5. Click Scan. 

What is Resolution? 
Resolution is the amount of information in a digital image.  Resolution is the number of dots that exist in a 
given area, and it is measured in dots per inch, or dpi.  Resolution affects how an image is displayed on a 
computer monitor differently than in print.  On a computer, an increase in resolution will increase the 
display size of the image, as well as the image file size.  On a printer, higher resolution will increase the 
quality of the printed image.  The following table shows the amount of resolution that should be used for 
an image depending on its destination and purpose: 

Resolution When to use it 

72 dpi Use for images that will be displayed on the Web “as is”. 

150 dpi  Use for images that will be cropped or edited and then displayed on the Web. 

300-600 dpi Use for images that will be printed. 
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For Web 

If you are going to scan in, or use an image for the web you should not use a higher resolution than 72-
150 dpi, because Windows computer monitors have a 96 dpi resolution, while Macintosh computer 
monitors have 72 dpi.  Using a higher resolution for computer display will only increase your file size and 
not the quality of the displayed image. 

For Print 

If you are going to scan an image for print, you should use at least 300-600 dpi.  Most printers are 
capable of printing at least 600 dpi.  Depending on your tools for importing images and the capabilities of 
your printer you can even use a higher resolution for print.  

How to Adjust Resolution in Photoshop 

Increasing the resolution will make the image larger on a 
computer screen.  It also increases the file size, but does 
not increase the quality of the image when it is displayed on 
a monitor. Images with higher resolution will, however, print 
with higher quality.  When possible, rescanning an image at 
a higher resolution is a much better option than increasing 
its resolution after it has been scanned.  To view image size 
and resolution, choose Image  Resize  Image Size. 

Pixel Dimensions 

The numbers displayed in these fields indicate how many 
pixels high and wide your image is.  

Document Size 

The Document Size section determines how large your image will be when printed out. 

Saving 
Be sure to save a copy of your file as a Photoshop document (PSD) before creating a JPG or GIF.  This 
PSD formatted file will be your master document.  If you plan on saving JPGs or GIFs, save separate 
copies, using one of the different Photoshop Elements saving options. 

Before you save your image refer to the next section, File Formats, for a better understanding of what file 
format you should use for your image.  

 Save:  To save your file as a standard Photoshop file, choose File  Save. 

 Save As:  If you would like to save a copy of your file in a different format, such as GIF or JPG, 
choose File  Save As and select the appropriate format from the pull-down menu.  One of the 
most important options for a JPG is Quality.  You can choose a quality from the pull-down menu 
(Low, Medium, High, or Maximum).  You can also slide the small triangle left and right across 
the horizontal line.  Keep in mind that the file size of high quality images will be larger than lower 
quality images.  If you are saving an image for print, use low compression.  If you are saving an 
image for use on the Web, apply as much compression as possible while still preserving 
reasonable image quality. 

 Save for Web:  Photoshop lets you optimize the display and file size of your images for effective 
Web publishing.  Optimization is the process of compressing an image and setting display options 
for use on the Web/e-mail. 

Since JPGs and GIFs are used as web image files, only these formats can be used.  A pull down menu 
on the top-right corner will display these format options.  In addition, if you select GIF as your format of 
choice, you can make the image transparent by checking the Transparency Option. 

 
 
 

Image Size Window 
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File Formats  

PSD 

This is the Photoshop file format.  Any native Photoshop Elements file that is saved without selecting any 
other file format will automatically be a PSD file.  It is always good to keep the original file as a PSD 
(Photoshop) file because it contains the most data and it allows for easy editing of image layers. 

JPG, JPEG 

JPG is an acronym for Joint Photographic Expert Group.  This format works well for images that will be 
published on the Web.  Since JPG Files tend to be small, JPG is a good choice for photographs or 
images that are emailed.  If you will be printing a JPG image, make sure that the compression settings 
are set to obtain high print quality.  

GIF 

GIF stands for Graphics Interchange Format.  Like JPEG files, GIF files are best used for on-screen 
applications, usually the Web.  GIF images can contain a maximum of 256 colors, and therefore are best 
used with simple graphics and clip art. 

Photoshop Elements 
Work Area 

Toolbox, Palettes, the Toolbar 
and Menus  

The Photoshop Elements work area 
includes the Toolbox, Palettes and 
Palette Well, Option Bar, Toolbar with 
pull down Menus, and the Canvas. 

The Toolbox  

The Toolbox Palette offers shortcuts 
for different tools. To select a tool from 
the Toolbox, click on its icon. Icons 
with small black arrows in the lower 
right corner have multiple tools. To 
select a hidden tool, click and hold your 
mouse button on the tool’s icon and 
then select the desired tool. 

Photoshop Elements 2 
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The Toolbox 

 

The rectangular marquee tool selects 

part of an image.  
The move tool moves or copies selections 

and layers.  

The lasso tool lets you create a freehand 

selection. 
The magic wand tool lets you select a 

similarly colored area. 

The type tool allows you to enter and 

format text on an image. 

The linear gradient tool creates a gradual 

blend of colors. 

Use the eyedropper tool to select the 

sample of a color from an image. 

The zoom tool allows you to magnify or 

reduce your view of images. 

The hand tool is used to scroll an image. 

The rubber stamp tool will take a sample 
of the image, which you can apply over 
another image, or elsewhere in the same 

image. 

The blur tool creates a diffused, 

softened effect. 

The eraser tool lets you erase part of an 

image. 

The paintbrush tool lets you add color to 
an image in various hues with different 

brush sizes. 

The paint bucket tool fills selected areas 
with colors, such as a marquee 

selection. 

The dodge tool lightens an area of the 

image. 

The red eye tool can be used to change an 

object’s color. 

The sponge tool changes the color 

saturation in an area of the image. 

Use the shape tool to create various 

shapes. 

Selection brush lets you select an area 

of your image using brushes. 

The pencil is used to draw freehand lines. 

The sharpen tool will sharpen softer 

edges. 

The smudge tool pushes part of the image, 

like a finger in wet paint. 

Background color selects the background 

color you will use. Foreground color selects the foreground 

color you will use. 

The burn tool darkens an area of the 

image. 

The crop tool allows you to crop parts of 

an image. 
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Palettes 

Palettes are listed under the Window Menu to help monitor and edit images.  

There are two types of palettes:  floating palettes and the palettes contained in the Palette Well.  

The Layers Palette 

The layers palette shows the layers in an image.  The order of the layers in the palette shows the stacking 
order of the layers in the image.  

Undo History Palette  

The Undo History Palette allows you to revert to a previous state of your image.  If you go back to a 
previous state of the image using the Undo History Palette, the current state of the image will be deleted.   

To revert to a previous state of the image just click on the state that you would like to go back to. 

Hints Palette  

The Hints palette displays illustrations and descriptions about any tool and any other palette.  

How-To Palette 

The how-to palette contains sets of instructions, called recipes that guide you through different activities.  

Layers 

Think of a layer as a clear acetate sheet on where you can place an object (image).  Layers allow you to 
select each object individually.  You can modify a specific object while additional objects that are 
contained in other layers remain unchanged.  Whenever you want to select a layer for editing, simply click 
on the layer’s name in the Layers Palette.  If you create many objects on one layer, you may run into 
trouble when trying to select specific parts.  However, if you assign a layer to each and every object, each 
layer can be easily selected while the rest of the image is left untouched. 

To hide or show a layer: 

 Find the layer you wish to hide or re-show. 

 Click on the layer’s Eye icon.  

You can safely toggle the eye on and off without losing data in your image.  The purpose of the eye icon 
is to preview what your image looks like with or without certain layers being displayed. 

To rearrange the order of a layer: 

 Click and hold the layer’s name you wish to rearrange. 

 Drag that layer above or below other layers. 

There are several ways to add layers to an image.  One method is to click the New Layer icon , 
located at the bottom of the Layers Palette, to create a new layer from scratch.  To paste something that 
has been copied onto the clipboard, select File  Paste. 

While you can add images to the background layer, the background layer itself cannot be moved or 
deleted because it is locked, indicated by the Lock icon next to the name of the Layer. To delete any 
other layer, click the layer’s name to select it and then click on the Delete Layer icon. 

Tools 

The Crop Tool 

This tool allows you to trim your image by selecting an area to keep and discarding the rest.  
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To select and crop your image, follow the steps below: 

1. Select the Crop Tool from the toolbox. 

2. Create a selection by clicking and dragging your mouse from a starting corner to the opposite corner. 

3. A frame will appear around the desired section of the image.  The rectangular-shaped frame has a 
small square on each corner, one on each side, and a crosshair in the center.  Change the area 
selected for cropping by clicking and dragging any of the little squares on the cropping frame. 

The Type Tool 

This tool allows you to add editable text to an image. 

To use the Type Tool, follow these steps: 

1. Select the Type Tool from the Toolbox 

2. Go to the area in the Canvas where you wish to enter text (you can move the text later if you need 
to). 

3. Type the desired text. 

4. While your text is highlighted, you can edit it from the Options Bar to change the font, make it bold or 
increase the size. 

Note: If you are adding text to an image, Photoshop will create a separate Layer in which the text is 
contained.  

Selection Tools: The Marquee Tool and the Lasso Tool 

There are a variety of tools that you can use for creating selections. These tools are the Marquee Tool, 
the Lasso Tool, Polygonal Lasso Tool, Magnetic Lasso Tool and the Magic Wand. 

The selection tools allow you to select, deselect, inverse, select all, reselect and more. 

Toolbar Menus and Common Menu Options 
Photoshop includes the following pull down menus: File, Edit, Image, Enhance, Layer, Select, Filter, 
View, Window and Help.  Listed below are commonly used menu options. 

Rotate 

The Rotate command can be found under the Image menu.  If you don’t have a specified angle at which 
you wish to rotate your image, use Free Rotate. 

To rotate an image, perform the following steps: 

1. Select the image, layer, or area that you want to rotate. 

2. Choose Image  Rotate  Free Rotate. 

3. The image will be bordered by the transform margin, so you can rotate the image by clicking and 
dragging anywhere outside of that margin. 

 

If you want to rotate the image at exactly 180º, 90º CW (clockwise), or 90º CCW (counter-clockwise), 
choose Image  Rotate, select 180º, 90º, CW or CCW, as desired. 

Resize 

Resizing an image is a very common task.  To resize an image: 

 Go to Image  Resize  Image Size…  
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 Enter either new Pixel Dimensions (for images that will be displayed on the screen), or enter 
new Document Size (for images that will be printed). 

Constrain Proportions  

If this option is checked, the proportions of your image will be kept intact as you resize it.  If the box is not 
checked, and you entered a value in one of the two dimensions (width or height), the proportion of your 
image would be lost, and your image would look distorted (too wide or too tall).  Make sure the option is 
checked if you want the proportions to remain the same as you resize your image. 

To resize an area of your image (as opposed to the entire image) follow the steps below, using any of the 
selection tools and select the area of the image that you wish to resize. 

 Go to Image  Resize  Scale. 

 In the Options Bar, make sure the Constrain Proportions icon is enabled. 

 Enter a percentage on the Width (W:) or the Height (H:). 

Retouching and Enhancing Images 

Quick Fix 

The Quick Fix feature is found under 
Enhance in the menu bar. It offers a 
basic set of tools and techniques 
used to correct and enhance photos.  
The image adjustments contained in 
the Quick Fix are also available 
individually under the Enhance 
menu.  Quick Fix contains 
adjustment categories like 
brightness, color correction, focus 
and rotate. 

Auto Levels 

Your image has a range of colors 
and values.  To adjust the overall color quality of your scan, use Auto Levels.  The quickest and easiest 
way to adjust your levels is to simply let Elements adjust them for you.  Auto Levels defines the lightest 
and darkest color as black and white, and distributes the intermediate pixel values accordingly.  

Note: Using Auto Levels will not always result in an improvement to the quality of your image; if the 
results are not satisfactory, you can Undo the changes through the Edit menu. 

To apply the Auto Levels command to your image: 

 Select EnhanceAuto Levels. 

 Click OK. The change can be subtle, so to compare the unadjusted image with the adjusted 
image, press CTRL-Z (PC) or COMMAND-Z (Mac) to undo and CTRL-Y (PC) or COMMAND-Y 
(Mac) to redo. (You may see no difference at all). 

Using Layer Styles, Effects and Filters 
If you want to apply different effects to your image or enhance your photographs use the Layer Styles, 
Filter or Effects Palettes.  

The Layer Styles Palette 

Styles can be applied to layers, which can be text or shapes.  To apply a style, select a layer and choose 
the style you want from the different style categories offered in the Layer Styles Palette.  

 

Auto Levels adjusts the overall color and light 

quality of an image 
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The Effects Palette 

The Effects Palette offers different options to alter your image.  Some effects can only be applied to a 
selection of the image, a selected layer or a type layer.  To apply an effect select you layer and double 
click on the name of the effect or choose the effect and click apply from the Effects Palette.  

The Filters Palette 

The Filters Palette offers the same filter categories that can be found under the Filter Menu in the main 
menu bar.  Filters can be applied to an entire layer or just selected parts of an image.  To apply a filter, 
choose you layer, or selection and double click on the filter, or click apply from the Filter Palette.  

Red Eye Removal 

If you’ve ever taken pictures with a flash, you’ve probably developed at least one picture where someone 
in the photo has red eyes.  Photoshop provides a Recipe for red eye removal.  Below is a quick 
description on how to remove red eye.  

1. Zoom in enough to see pixels.  Use the Magnifying tool (from the Toolbox) to zoom in.  If the image 
isn’t zoomed in enough, it will be difficult to select the color you wish to replace.  

2. Select the Red Eye Removal tool.  Make sure the brush size is not too big or too small.  Otherwise, 
you may cover an area bigger or smaller than the eye you wish to correct.  To select a different brush 
size, go to the Options Bar  Brush.  Now, choose First Click from the Sampling drop down menu. 

3. Choose an appropriate replacement color.  Click on the foreground color box and then select an 
appropriate color with which to replace the red in the eyes.  

4. Drag carefully.  Click on the red area of the eye and hold your mouse button while dragging 
throughout the red.  Make sure you stay within the eye; otherwise you may change the color of an 
area you didn’t want to change.  The Red Eye Removal Tool replaces colors similar to the one on 
which you first clicked.  

5. Change one eye at a time.   After you have changed one eye, release the mouse button, move to 
the other eye, and click again to change the color of the second eye.  If you simply drag the tool from 
one eye to the next, Photoshop may streak some color across the image. 

6. When you are finished zoom out to 100% to see the effects of the Red Eye Tool. 

Importing Your Image into another Application 
It is always better to edit/resize your image in Adobe Photoshop Elements before importing or uploading 
your image.  Resizing an image within another program, such as Macromedia Dreamweaver, can result in 
distortion of the image.  Always remember to position your cursor where you want your image to be 
placed. 

For More Information 
For more information on Photoshop, go to the go to the ITS Support Site at 
https://www.ithaca.edu/computing/support/.  For additional help, contact the ITS Helpdesk at 
helpdesk@ithaca.edu or 4-3282. 
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